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0 Introduction
The c language has always been a compiled language. This means
that the programmer has to t]?e in his or her program ald then
compile it to change the program into machine code.

Unfortunately this process normally takes several minutes and only
then can you execute your program,

HiSoft C takes a different approach.

It is a C Interpreter. This means you type in your program and
execute it immediately as with a BASIC interpreter. There's no
waiung around for compilers and linkers.

To do this, Hisoft C has a powerful GEM-based editor which lets you
edit up to eight files at once. You can even create modular programs
and then, with a simple click of the mouse, run these modules
together.

This gives you an easy-to-use environment where you can spot
errors much more quickly than with a compiler. You can even single
step and put breakpoints in your code.

Hisoft C gives the C language the accessibility of BASIC without
losing the language's power. So HiSoft C is aimed at two categories of
nr^drernrnerq '

. Beginners will ffnd Hisoft C gives them a very easy way to learn
the C language.

C is the language around which the Atari ST is based and is the
language of choice for many professional programmers. Many
newcomers to the ST decide that they would like to try out this
powerful larguage. So they buy a compiler, but it seems to take
forever to get their first program to run because of numerous
compiler or linker errors.

This interpreter lets beginners discover the C language more
gently, using an environment that reminds them (or you!) of
BASIC,

. Experienced programmers vdll find Hisoft C provides a faster
'way to develop their programs.

lnlroducfion HiSofi C Poge I



Compiled and assembly language functions can be loaded and
used with interpreted modules. Htsoft C also supports almost
the full C language as described in Kernighan & Ritchie *The C
Programming Language' (First Edition).

Developers can use IIlSoft C to develop their programs with all
the advantages this gives and then, 

"vhen 
their application is

ffnished, just compile to a finished product.

Porting programs written with the interpreter is easy as long as you
respecl 

-the 
standard rules of programming. Nevertheless, each

implementation of C (whether a compiler or interpreter) has its own
pe6utarities and extensions; so some work may be needed. This is-the 

case when moving code between a compiler and the interpreter
and between two comPilers.

Hisoft C has a Iibrary of460 functions. These are detailed in Section
4 and include the usual ANSI, UNIX, C, GEM and DOS standard
ftrnctlons. In addition, Hisoft C has a toolbox of functions which are
both simple and powerful, to make programming with menus, dialog
boxes and windows much easier.

So, thanks to Hisoft C, you can easily write programs that use all the
facilities of your machine, with or withoqt GEM' Fina-lly, if -you need
faster running code you can use your favourite compiler (Lattice C
from HiSoft, we hope!) to speed up your programs.

.I moKe q oocK-u
Before using IIlSoft C you shotrld make a back-up copy of both the
distributon disks and put the original away in a safe place. They are
not copy-protected to allow easy back-up and to avoid inconvenience.
'ffre didts may be backed-up using the Desktop or any-back-up
utifty. The didks are single-sided but may be used in double-sided
drives.

If vou have a double-sided disk drive you can copy the contents of
bo-th disks on to one double-sided disk. If you have a hard disk, just
drag the files to a folder on your hard disk.

Before hiding away your master disks make a note in the box below
of the serial num6ei written on them. You will need to quote this if
you requfe technical support.

Serial No:

Poge 2 Hisott C lnfloduclion



Reoistrotion Cqrd
Enclosed with this manual is a registration card which you should
fil1 in and return to us after reading the licence statement. Without it
you will not be entiUed to technical support or upgrades. Be sure to
h[ in atl the details, especially the serial number and version number.
The version number is given in the Aboui box when you run HiSoft C.

HiSo ontenls
The Hisoft c disk 1 contains the following files:

H c . PRG the interpreter itself

Fl. rc - F11 .Ic supplementary files the interpreter needs

READlv lE.TxT see below for  deta i ls

The HiSoft C disk 2 contains the following folders:

H E A D E R

H E L P

E X A I . I P L E S

S O U R C E

D U I V ] P F I L E .  '

R E S O U R C E . *

C H E C K S T . P R G

the standard C header files

the information files used by the editor help
command

example C programs

the source code to the HiSoft C toolbox. See
Appendix D. I

the files for the resource file of the DUI'4PFI LE. c
example

the files for the rsource file of the REs0uRcE. c
example

a program to give details of your machine. Please
include this information when writing to us.

lnfroducfion HiSofi C Poge 3



The e
As with a-11 Hisoft products Hisoft C is continually being improved
and the latest details that cannot be included in this manual may be
found in the README . TxT file on the disk. This file should be read at
this point, by double-clicking on its icon from the Desktop and then
clicking on the Show button. You can print it by clicking on the Print
button.

0.5 Usino this monuol
Different sections of this manual are aimed at different readers.

After this introduction, Secfion I describes how to use the Editor
and Interpreter and so everyone should read this.

Seclion 2 is an introducfion to the C language for those of you who
are new to the language.

Section 3 is an introduction for those new to programming in GEM,
whether experienced or novice C programmers. This section also
provides a description of the Hisoft C GEM toolbox for experienced
GEM programmers.

Seclion 4 describes the 460 functions of the Hlsoft C libraljr. This is
mainly designed for reference and includes a summary so you can
find which flrnction you need lor a particu]arjob.

Appendix A contains the answers to the Exercises set in the tutorial
in Section 2. You will need to use this as you work through Section 2.

Appendix B is the reference language for the C interpreter and is
aimed at the experienced programmer.

Appendix C covers the interpreter's error messages and is designed
to be used as a reference if you don't understand an error message.

Appendix D covers porting programs to and from Hisoft C from and
to other implementafons.

Appendix E is the Bibliography which recommends some further
reading on the C langauge and the ST itself.

Appendix F covers technical support ald upgrades.

Finally, there's the index.

Poge 4 Hisoft C lniroduction



l . l  The Kevboqrd ond the cursor

I Usin HiSoft C
- 

This section describes how to write, modi8/ and run a program with
\- HiSoft C.

. l  . l  The Edi lor

As soon as you load Htsoft C a menu bar appears and a window
covers most of the screen. HiSoft C uses GEM and the mouse to make
your work easier. The menu lets you select the editor and execution
options. The program that you t,?e in vrill appear ln the window.

At the top left of the window you w'ill see a flashing block cursor. This
indicates where the characters you tlpe will be inserted.

The editor is a full-screen editor; that is to say you can move the
cursor where you like within the window and immediately change
the text as you wish.

Hisoft C lets you work with eight Iiles at the same time. If you cannot
see the file that you n/ant at a given instant you can very easily
switch from one to another.

l . l . e cutsor

You can move the crrrsor in all four directions by pressing the cursor
keys labelled -;1and Jto the rigfrt ofthe keyboard. You can also use
C o n t r o t  S ,  C o n t r o I  D ,  C o n t r o L  E  a n d  C o n t r o L  x  r e s p e c t i v e l y .

You can position the cursor by moving the mouse and clicking at the
point to which you wish to move.

You can also use the vertical scroll bar and the window's arrov/ icons
to change the cursor position.

The following keys are for rapid cursor movement withln the text:

s h  i f t  < , ,
S h  i f  t  >
c o n t f o [  +
C o n t  r o  l .  - t

moves to the start of line
rnoves to the end of line
moves to the end of the previous word
moves to the start of the next word

Using Hisoft C Hisoft C Poge 5



.1 . e e

The following keys modify the text in some way:

D e t e t e deletes the character under the cursor.

B a c k s P a c e deletes the character to the ieft of the cursor.

R e t u r n inserts a carriage return. If the cursor isn't at
the end of the line the llne is spllt at the cursor
position and the cursor moves to the beginning
of the new line.

C o n t r o t
R e t u r n

inserts a new line without splitting tbe current
one.

t a o inserts a tab character at the cursor position
thus moving the cursor to the next tab position.

S h i f t  T a b moves to tie previous tab position.

U n d o
'Undoes' any changes to the current line.

H e l . p displays some help information on a speciffed
subj ect.

H O m e moves the cursor to the start ofthe C block. A C
block is a sequence of instrucuons sr.rrounded
bv curlv brackets { and }.

S h i f t  H o m e moves the cr:rsor to the end of the c block.

E s c See Seclion I .1.6.

A L t e r n a t e
to
A L t e f n a t e

1

8

select one of the eight possible flles.

Ttrere's no need to remember these by heart; they can be displayed \-
by selecting Cursor keys from the Help menu.

Poge 6 Hisofi C Using Hisoft C



Funclion ke

The flrncuon keys when used with the s h i f t key work as ten macro
function keys that can be modiffed by the user. See Seciion 1.7.1.

When the function keys are used without the shi ft key they have
the following meanings:

Deletes to the end of the word : under the cursor.
A word consists of a sequence of characters
seoarated bv blanks or the ends of lines.

Inseri the last word which has been deleted with
Fl to the right ofthe cursor. If F3 rvas used since
F 1 then the line deleted by F5 is used.

F 3 or Delete the line containing the cu-rsor.
C o n t r o l . Y

F 4 Insert after the current line the last word
deleted wit]l r t or the last line deleted vdt]l F 5.

Insert an empty line after the current line and
Dosiuon the cursor there.

t )

Join tl.e next line to the end of the current one
by copying.

F 6

Comment out the current line. If the line was
originally commented out the comment is
removed.

F 7

Delete to the end of the current line. This may
notbe recovered with F2 or F4

F 8

F9 or Move the cursor 23 lines [a screen full) towards
cont ro [- R the start ofthe lile.

F 10 or Move the cursor 23 lines (a screen full) towards
Cont  ro L-C the end of  text .

! The function keys item from the Help menu may also be used to
display a summ#y of these keys.
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l . Menu shorl culs

The major commands can be accessed from the keyboard without
having to use the mouse to access the menus.

In Eeneral these comblnations consist of either the ALternate or
thdc o n t 

" 
o L keys with a letter or digit.

To the right of the menu entries is a single letter. If this is a capital
fupper case) then this item may be selected with A t t e r n a t e and the
letter key. If this is in lower case then it can be selected with c o n t I o I
and the letter.

Here is a list of the key combinations and the corresponding menu
item.

A L t e r n a t e  A
A L t e r n a t e  B
A L t e r n a t e  F
A L t e r n a t e  G
A L t e r n a t e  I
A L t e r n a t e  J
A L t e r n a t e  L
A L t e r n a t e  F I
A L t e r n a t e  N
A L t e r n a t e  0
A L t e r n a t e  P
A L t e r n a t e  Q
A t t e r n a t e  R
A L t e r n a t e  S
S h i f t  A l . t e r n a t e  S

Abandon
Bottom of file
Find
Go to line
Insert {ile
l-oad proj ect
Load file
Module list
Repeat {ind (Next)
q. \ .F  ^n+ i^nc

Program Information
Ouit HiSoft C
Fin . l  R '  ran lq^c

Save as
Save ffle
Top of ffle
Informauon on the variables
Rr-rn (eXecute)
Go to last position
Set mark 1
Set mark 2
Go to mark 1
Go to mark 2
Page down
Cursor dght
Cursor up
Page up
Cursor left
Cursor down
Delete line

A l . t e r n a t e  T
A l . t e r n a t e  V
A L t e r n a t e  X
A L t e r n a t e  Z
C o n t  r o  t  1
C o n t r o L  z
C o n t r o L  3
C o n t  r o  L  4
C o n t r o L  C
C o n t r o L  D
c o n t r o L  E
C o n t  r o  t  R
C o n t r o l .  S
C o n t  r o  t  X
C o n t r o l "  Y
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These combinations of keys may be modified to configure the
keyboard in the way that you want; you can thus make the editor
similar to any editor that you are used to.

See Section L8.3 for details.

l . l Ke or complel ion

This facitity can save a lot of typing and looking up the syntax of
functions.

You tlTe only the beginning of the name, and the complete function
call (inaluding the parameters) is automatically created by the editor.

For example if you type:

s t r n i

and then press the r s c key, the editor will display:

s t r n i  c n p ( s t  f  1 , s t r 2 , n )

on the screen, with the cursor one the ffrst argument of thefunction.
You are now in E s c mode. l,ook at the top right corner of thescreen.
E s c is displayed, instead of t n s. The editor is waiting for you to t)?e
in the arguments of the function. After each parameter, you should
press Reiurn, and the cursor is posiUoned on the first character of
the nertargument.

The parameter names which are written by the editor are
automatically replaced by the new names you t14re. You don't need to
erase the old names with eackspace or De l.;just type the new one
and press R e t u r n. If you don't v/ant tochange the name of a
parameter, just t]?e Return.

You exit E s c mode when you have tlped in a1l the parameters, or
when you use cursor keys or select a menu item.

E s c mode can also be used with the C language kelwords, as follows:

short cut statement
I f o r

u h i  L e

s $ r i t c h

t The list of the functions and parameters used by E s c mode is in file
Fi 1. rc. You can modiry this as you wish.

Using Hisoft C Hisoft C Poge 9



.1 .7 Menu commonds

You know how to select a menu item, now we will examine the various
menus in detail.

On the far left are the credits! The first entry under the Atari logo,
which is equivalent to the Desk menu on many ST programs, is the
credit for the author of the program.

In the Info menu on the far right, the
Progrom info command displays a dialog
box which gives some statistics for the
current program. With this you can see
how many lines your program has, the
free memory figure, how much memory
this program needs and where the
cursor is in the text. The other
commands on this menu will be
discussed later.

The Move menu commands are also useful:

Top of file moves the cursor to
the front of your program and
Bottom of File moves to the end
(oh good - you guessed).

When you click on the Go to
Iine.., item a dialog box appears
and asks you to enter the line
number that you want to move
to. You are not allowed to move
past the end of text.

There are a set of commands
that some people find incredibly
useful and other people find a
waste of time. As they weren't
difficult to program, they have
been put in HiSoft C.

These are the marks. You set a mark in your program at the cursor
position and then after you have moved tJ e cursor you ca:r retum to
the place that you marked. There are two different marks that you
can use.

0vc  curs0r  - - - - - -
Top o f  f i l e  [ tT
Botton of f i  le [ tB
Eo to  l i ne  , , ,  06
60 t r  ies t  pos i t io t  l {Z

l lerks ----------
Set nark I ^1
set r,rark 7 ^Z
So to nerk I ^3
[o to n€rk Z ^4

------ opt i ars
y' Inde ntat i  on

f ,u to  l ine  sp l i t
Se t  tab  I  eng th

Pdge l0 Hisoft C Using Hisott C



L,

t_

L
(-

L

L

L

L

L

L

L

L

L

The command Set mork I sets the first mark at the cursor posi on;
to return there use the Go to mork I command. Naturally Set mork 2
and Go to mork 2 perform the same operations for the second mark.

The Go to lost position command is similar to the marks. It is as if a
mark was automatically placed at the last cursor posiuon that the
text v/as changed. Wtren you click on this command the cursor
moves to the last place that the text was modified.

This is very useful when you are twing in a program. It lets you
interrupt your typing, have a look at another part of the program
and then continue tj?ing where you were before.

Note ttrat the marks can be used to move between modules. If you go
to a mark that is in a different module, the module switching is
automauc.

I e File menu

ea
Load f i le  ' JL
Inseft f i  le [ t I
--- l,{r i tt

Save fi le r{ts
saue as, , ,  ( rs

---- {}st iats ------
Save options 00

y' Confirn abandon
y' Confirn overHf i  te
y '  Backup f i le

Text ed i  tof
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The Lood file command
enough.

We will now describe most of the items
on the File menu.

The Quii command lets you leave HiSoft
C after asking whether you wish to
save any unsaved work. If you realise
that you don't want to quit you can
cancel this cornmand.

Abondon c lears the program in
memory and leaves you with a blank
screen. If you have modified the
program without saving it you will be
warneo,

Note that, with Abondon, only the
curent text is deleted. The other seven
modules are left alone. This oDtion. as
well as the Lood file, Insert file, Sove File,
and Sove os commands, only affects
the current module.

loads a file into memory, surprisingly
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